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technical data, and recommendations in this document are believed to be accurate and reliable, but are 
presented without express or implied warranty. Users must take full responsibility for their applications of any 
products specified in this document. The information in this document is proprietary to Nortel Networks.

The software described in this document is furnished under a license agreement and may be used only in 
accordance with the terms of that license. The software license agreement is included in this document.

Trademarks
*Nortel, Nortel Networks, the Nortel logo, and the Globemark are trademarks of Nortel Networks.

All other trademarks and registered trademarks are the property of their respective owners.

Disclaimer
The network plan generated by the WMS planning tool uses a predictive RF model.  This information is an 
estimate only of the amount, configuration, and placement of WLAN 2300 equipment and is intended to 
approximate project cost projections. 

A Wireless LAN site survey service captures actual RF data to accurately model RF environments and is still 
the best method to determine correct location of APs, and therefore installation locations of cabling. A WMS 
network plan is an approximation only and does not substitute for a Wireless LAN site survey.
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How to get help

This section explains how to get help for Nortel products and services.

Getting help from the Nortel web site

The best way to get technical support for Nortel products is from the Nortel Technical 
Support web site:

http://www.nortel.com/support

This site provides quick access to software, documentation, bulletins, and tools to address 
issues with Nortel products. More specifically, the site enables you to:

download software, documentation, and product bulletins

search the Technical Support web site and the Nortel Knowledge Base for answers to 
technical issues

sign up for automatic notification of new software and documentation for Nortel 
equipment

open and manage technical support cases

Getting help over the phone from a Nortel solutions center

If you do not find the information you require on the Nortel Technical Support web site, and 
you have a Nortel support contract, you can also receive help over the phone from a Nortel 
Solutions Center. 

In North America, call 1-800-4NORTEL (1-800-466-7835).

Outside North America, go to the following web site to obtain the phone number for your 
region:

http://www.nortel.com/callus
320667-C Rev.04
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Getting help from a specialist by using an express routing code 

To access some Nortel Technical Solutions Centers, you can use an Express Routing Code 
(ERC) to quickly route your call to a specialist in your Nortel product or service. To locate 
the ERC for your product or service, go to:

http://www.nortel.com/erc

Getting help through a Nortel distributor or reseller 

If you purchased a service contract for your Nortel product from a distributor or authorized 
reseller, contact the technical support staff for that distributor or reseller.
Nortel WMS 2300 Series Release Notes 4.1.15
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Nortel WLAN Management Software 2300 
Series Release Notes 4.1.15

Nortel recommends that you familiarize yourself with these release notes and the Nortel WLAN Management 
Software User’s Guide and Nortel WMS Reference Manual before installation. For additional product 
information, refer to the following documents:

Nortel WLAN Security Switch 2300 Series Quick Start Guide. 

Nortel WLAN Security Switch 2300 Series Installation and Basic Configuration Guide. 

Nortel WLAN Security Switch 2300 Series Configuration Guide. 

Nortel WLAN Security Switch 2300 Series Command Line Reference. 

What's New in WLAN Management 
Software Version 4.1.15

Nortel has enhanced the WLAN 2300 series software to meet regulatory requirements in specific EU, CALA 
and APAC countries. A mandatory upgrade is required for: Australia, Brazil, Chile, France, Korea, Malaysia, 
Mexico, Panama, Peru, Venezuela. It is recommended all other customers in EU, APAC and CALA upgrade to 
WSS Release 4.1.14 and their WMS software to Release 4.1.15. 

Please refer to the "Approved Countries for the WLAN 2300 Series Components"at 
http://www.nortel.com/support for a complete listing of approved counties for using WLAN 2300 series 
software and their associated two-letter country codes.
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Description of regulatory complicance modifications to WSS and WMS software 

The following software updates have been made to the WSS and WMS software to ensure global regulatory 
compliance: 

Modified the antenna gain specifications to coincide with the measured results. 

• The accurate peak and average gain values are now used to calculate the correct power settings 
for the radios. 

• Adjusted band edge power settings for all 802.11g entries to match measured regulatory data 
and ensure compliance to local regulatory limits. 

Additional regulatory information and operating parameters were implemented for newly 
homologated countries. 

Corrected operating parameters for DFS performance in selected “Affected Countries”. 

Disabled operation in the 5.25GHz to 5.35GHz and 5.47GHz to 5.725GHz for France to meet the 
DFS requirements for EN301-893v1.3.1

Issues resolved since software release 4.1.14 are as stated beginning on page 20

WLAN Management Software 4.1 has the following enhancements.

Support for WSS Software Version 4.1 Enhancements
WLAN Management Software 4.1 supports configuration and management of the following WSS Software 
enhancements:

• Default AAA attributes for SSIDs

• On-demand countermeasures

• Layer 2 traffic restriction among clients in a VLAN

• Network domains (Mobility Domain clustering)

• Configurable idle timeout for CLI management sessions

• Configurable Class-of-Service (CoS) mapping

• Support for periodic mark messages in the system log, to provide date and time information for 
troubleshooting

• MIB additions

• Support for 150 rules in a location policy

For more information about these features, see the WSS Software 4.1 release notes.

WMS license key activation
The planning and monitoring service features of WMS are licensed and require installation of license keys. 
Support for 50, 250, unlimited APs, and Planning Tool are activated using License Activation Keys.

A License Certificate is used to provide a single software license and its associated License Activation Key. 
The activation of the Planning feature and or the number of managed Access Points for your Nortel WLAN 
Management Software depends on the purchased software features.
Nortel WMS 2300 Series Release Notes 4.1.15
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To activate support or add additional functionality, you must obtain a License Activation Key from Nortel, and 
load the License Activation Key into the original host computer. To obtain the License Activation Key, follow 
the instructions on the License Certificate provided with the WMS Software Kit by Nortel.

When the proper License Activation Key is obtained, follow these instructions to enable the 
WMS functionality:

1 Load the WMS Application into the host computer. (Note: Ensure the software is loaded into the host 
computer that is specified in the License Key file.

2 Start WMS Application.

3 When the License Information dialog box appears, go to step 4. 
If the License Information dialog box does not appear, click Cancel to close the WMS Services 
Connection wizard, then select Help > Licensing from the menu bar. The License Information dialog box 
appears.

Figure 1:  License Information dialog box

4 Enter the authorization code and press Enter. 

A single authorization code activates all the requested application software.

5 Your Nortel WMS application is now active. Note: For technical issues, please contact Nortel Enterprise 
Technical Support (NETS). See also “How to get help” on page 4.

Base Server and Planning Licensing Changes

In WLAN Management Software Version 4.0, the planning license was required to do the following:

• Create a site, building or floor

• Edit a site, building or floor

• Import a floor diagram

• Create RF obstacles to build an RF model of the floor

• Manually place AP’s on a floor in a coverage area

• Create coverage areas

• Perform automated RF planning (Compute&Place, Assign Channels, Optimize Power)

• Integrate site survey data from network or Ekahau Site Survey to optimize the RF model of a floor
320667-C Rev.04
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• Perform location of devices on a floor plan

In WLAN Management Software Version 4.1, the planning license is more surgical, and results in more 
functions being available with the base server software license. You can do the following even without a 
planning license:

• Create a site, building or floor

• Edit a site, building or floor

• Import a floor diagram

• Manually place AP’s on a floor in a coverage area

• Create coverage areas

• Perform lower-resolution location of devices on a floor plan

A planning license is still required to do the following:

• Create RF obstacles to build an RF model of the floor

• Perform automated RF planning (Compute&Place, Assign Channels, Optimize Power)

• Integrate site survey data from network or Ekahau Site Survey to optimize the RF model of a floor

• Perform the most accurate location of devices on a floor plan

AP Licensing Changes

WLAN Management Software 4.0 enforced AP-based licenses by automatically unmanaging WSSs to bring 
the number of APs on managed switches down to the maximum number of APs allowed by the license. 
WLAN Management Software 4.1 does not unmanage switches but instead displays a reminder every 15 
minutes to remove APs or upgrade the license. The behavior change makes it easier to use APs that are 
dynamically configured by a Distributed AP profile instead of being statically configured. APs that are 
dynamically configured are each counted toward the licensed maximum when the APs become active, even 
though they are not statically configured on a specific switch. 

Scaling Enhancements
WLAN Management Software Version 4.1 can support up to 500 WSSs, 1000 APs, and 30,000 clients in a 
network plan.

GUI Enhancements

Simplified Menu Lists and Enhanced Tool Bar

The menus in WLAN Management Software 4.1 are simpler. Only three menu categories are provided: File, 
Tools, and Help. Access to other features is provided by the tool bar:

• Policies

• RF Planning

• Configuration

• Devices
Nortel WMS 2300 Series Release Notes 4.1.15
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• Monitor

• Rogue Detection

• Verification

• Events

• Reports

The tool bar also has Back and Forward buttons, which allow you to page through the options you’ve already 
visited. 

The following icons under the tool bar provide access to configuration options for WLAN Management 
Software: Edit (client) application preferences, Configure WLAN Management Software Services, Launch 
WLAN Management Software HTML Help.

The menu displayed by right-clicking on an object in the Organizer panel is also simplified. In 4.1, one or 
more of the following options are available: Copy, Paste, Paste Replace, and Delete. Other options that were 
present in 4.0, such as the Monitor options, are provided by the Monitor tool bar options. 

Task Lists

WLAN Management Software 4.1 simplifies equipment provisioning and wireless planning by providing task 
links in a new display area, the Task List panel. The Task List panel is located to the right of the Content panel. 
(The Content panel is the data display area to the right of the Organizer panel, which contains the tree view of 
objects in the network plan.) 

Here is an example of the tasks for configuring a wireless service. 
320667-C Rev.04
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The Task List panel lists tasks that are related to the object selected in the Organizer panel. In this example, the 
selected object is floor1-wc:Wireless:Wireless Services. 

When you click on a task, the configuration wizard for performing that task is displayed. For example, the 
following wizard page appears when you click the 802.1X Service Profile task.

panel
Task List
Nortel WMS 2300 Series Release Notes 4.1.15
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For more information, see “Wireless Service Wizards” on page 14.

New System Setup Wizard

The System Setup wizard guides you through configuration of SNMP, VLANs, RADIUS servers and groups, 
wireless services, and Auto-DAP settings. For each configuration item, the wizard links to other wizards for 
those items. Use of the wizard is optional. You can use it to configure some or all of these system settings, or 
you can use the individual wizards for the settings.

To access the System Setup wizard for a WSS in the network plan:

1 Select the Configuration tool bar option.
320667-C Rev.04
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2 Select the switch in the Organizer panel. (The Organizer panel is located on the left side of the WLAN 
Management Software window.)

3 Click System Setup in the Task List panel. (The Task List panel is located on the right side of the WLAN 
Management Software window.)

For usage information, see the following sections of the Nortel WLAN Management Software Reference 
Manual: 

• “Adding a WSS to the Network Plan” section in the “Configuring WSS System Parameters” chapter

• “Setting Up a Switch” section in the “Configuring WSS System Parameters” chapter

1. Select the switch. 2. Select System Setup.
Nortel WMS 2300 Series Release Notes 4.1.15
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• “Viewing and Configuring VLANs” in the “Configuring WSS System Parameters” chapter

• “Viewing and Configuring RADIUS Settings” in the “Configuring Authentication, Authorization, and 
Accounting Parameters” chapter

• “Viewing and Configuring Wireless Services” in the “Configuring Wireless Parameters” chapter

Wireless Service Wizards

The wireless service wizards guide you through configuration of the following types of services:

• 802.1X

• Voice over IP (VoIP)

• Web-Portal (Web-based AAA) access for users who log in using a web page

• Open access for guests

• Custom, for types of service other than those listed above

Each wizard configures settings for the following objects:

• SSIDs, including SSID name, type (encrypted or clear), and specific encryption settings if applicable

• Authentication methods (RADIUS servers or the switch’s local user database)

• RADIUS servers and groups

• Default VLAN to use if the VLAN is not otherwise specified (such as through a user attribute)

• For voice services, the VLAN to assign voice users to, and the prioritization method (WMM or a 
vendor-specific ACL)

You can configure services on an individual switch basis or in a policy.

To access the wireless service wizards for a WSS:

1 Select the Configuration tool bar option.

2 Select the switch in the Organizer panel. 

3 Click the plus sign next to the switch name to expand the object list.

4 Click the plus sign next to Wireless.

5 Select Wireless Services.

6 Select one of the following options in the Task List panel:

802.1X Service Profile

Voice Service Profile

Web-Portal Service Profile

Open Access Service Profile

Custom Service Profile

For information, see the “Viewing and Configuring Wireless Services” section in the “Configuring Wireless 
Parameters” chapter of the Nortel WLAN Management Software Reference Manual. 
320667-C Rev.04
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Enhanced Client Location
The algorithm to determine a client’s probable location and the graphical depiction of that location are 
enhanced in WLAN Management Software 4.1. In WLAN Management Software 4.0, the location was 
depicted with a circle around a single AP that had knowledge of the client. In WLAN Management Software 
4.1, the client’s location is estimated using data from multiple APs and is presented with colored squares, as 
shown in this example.

The client is most likely in the vicinity of the area indicated by the red squares in the floor plan. 

WLAN Management Software 4.1 also uses the same algorithm to display the estimated locations of clients of 
rogue or interfering devices.

The client location features require a floor plan. 

Enhanced Auto-DAP Support
WLAN Management Software 4.1 provides the following support for Distributed APs configured using a 
profile (auto-DAPs). These are APs that are not statically configured on a WSS. You can do the following:

• Use Auto-DAPs for RF planning.

• Configure an Auto-DAP profile in a policy or on individual switches. 

• Convert Auto-DAPs to statically configured APs.

In addition, WLAN Management Software Services includes Auto-DAPs in monitored data. 
Nortel WMS 2300 Series Release Notes 4.1.15
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For information, see the following in the Nortel WLAN Security Switch 2300 Series Command Line Reference.

• “Planning the Nortel Networks Mobility System” chapter

• “Viewing and Changing the Auto-DAP Profile” section in the “Configuring Wireless Parameters” chapter

• “Converting Auto DAPs into Statically Configured DAPs” section in the “Configuring WSS System 
Parameters” chapter

• “Monitoring the Network” chapter

Simplified Conversion of Dynamically Configured APs

WLAN Management Software 4.1 simplifies conversion of APs configured dynamically by a Distributed AP 
template (auto APs) into statically configured APs. After a dynamically configured AP boots and becomes 
active on a WSS:

1 Select the network plan name in the Organizer panel. (Alternatively, to convert only the APs being 
managed by a specific switch, select the WSS.) 

2 Select Convert Auto APs in the Task List panel. 

Configuration Changes Are Not Listed as CLI Commands
In WLAN Management Software 4.0 local and network changes to WSSs were listed in their CLI command 
form. In WLAN Management Software 4.1, they are listed as text descriptions. 

To list configuration changes, click Review. In the following example, SNMP configuration changes have been 
made to a switch in the network plan but not yet deployed to the live switch in the network.

Note.  The Review and Deploy buttons or equivalent tasks in the Task List panel are 
available only when WLAN Management Software can communicate with the live switch in 
the network. If the switch is in the network plan but WLAN Management Software is not 
communicating with the same switch in the network, the buttons are greyed out.
320667-C Rev.04
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Saves and Locks Are More Granular
In WLAN Management Software 4.0, changes to the network plan needed to be explicitly saved, by selecting 
the File > Save option. Until the Save option was selected, a lock went into effect for the entire plan as soon as 
changes were made to any part of the plan, until the plan was saved. In WLAN Management Software 4.1, 
changes to a network plan are automatically saved when you click Save or Apply in the Content panel or 
Finish or OK in a wizard. 

In addition, when a change is made to the network plan, only the part of the plan containing that change is 
locked. Other WLAN Management Software users can change other parts of the network plan (if they have the 
appropriate access level) even when the part of the plan you are changing still has unsaved changes. As soon as 
you click Save, Apply, Finish, or OK, the changes are saved and the lock is removed. 

Because of the significant changes in the procedure for making changes to a plan on the server, the File > Save 
menu item has been removed from WLAN Management Software Version 4.1.

Version Compatibility

• This version of WLAN Management Software has been verified against WSS Software Version 4.1 and 
also supports WSS Software Version 4.0. 

• Network plans created with WLAN Management Software 4.0 are compatible with this version of 
WLAN Management Software. If you want to use network plans created with previous versions of 
WLAN Management Software, make sure the option to delete the network plans directory is not checked 
when you uninstall. 

After you install the new software, WLAN Management Software asks whether the old network plans are 
to be sent to the server (if you want to keep them) or deleted. If multiple clients are using the same server, 
then the old network plans need to be copied only once. Nortel recommends that you archive the xml/db 
directory before you delete any old plans.  

• If you are installing for the first time, you must request a license from Nortel for each host on which you 
plan to install RF Planning or WLAN Management Software Services. You can use the WLAN 
Management Software serial number and a valid host name to request license keys for the following types 
of licenses:

RF Planning—Enables the RF modelling features of planning on a designated WLAN Management 
Software client installation. With an RF Planning license, you can create RF obstacles, compute and 
place equipment, assign radio channels, and optimize radio power settings. Without an RF Planning 
license, you still can import or create floor plans and create coverage areas. 

WLAN Management Software Services—Enables you to install WLAN Management Software 
Services (the WLAN Management Software server). 

Depending on the license, you might also have restrictions on the number of AP access points you can 
manage using WLAN Management Software. The WLAN Management Software client itself does not 
require a license. You can install the client on any number of hosts, and access licensed installations of 
WLAN Management Software Services from the installed clients.

Note.  WLAN Management Software 4.1 saves plans in the config-db directory and 
does not use an xml/db directory. 
Nortel WMS 2300 Series Release Notes 4.1.15



18 Supported platforms
When requesting a license, you must provide your serial number and the hostname of the system on 
which WLAN Management Software is to be installed, and indicate the feature you want to license. The 
serial number is included with your WLAN Management Software software packaging, on the box and 
also on the CD case. For installation instructions, see the Nortel WLAN Management Software Reference 
Manual.

Supported platforms

• Microsoft Windows Server 2003, Microsoft Windows XP with Service Pack 1 or higher, or Microsoft 
Windows 2000 with Service Pack 4 

• SUSE Linux 9.1 and Red Hat WS 3 

Upgrading from WLAN Management Software Version 
4.1

You can install the new version of WLAN Management Software on top of the one previously installed 
(WLAN Management Software 4.1.14). You do not need to uninstall the previous version.

Note.  You must use the English version of the operating system you select. Operating 
system versions in other languages are not supported with WMS.

Note.  The monitoring database cannot be migrated within the WMS install and will 
display the following message dialog. If you do not want to migrate the monitoring 
database, you may ignore this message and continue with the install. If you want to migrate 
the monitoring database, continue with the installation and migrate the monitoring database 
later using the C:\Program Files\Nortel\WMS\bin\dbtools command-line utility..
320667-C Rev.04
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Upgrading from WLAN Management Software Version 
4.0

If you are upgrading from WLAN Management Software Version 4.0 and you have network plans created or 
saved in Version 4.0, Nortel recommends that you archive the config-db directory before you install the 
upgrade. 

To install the upgrade:

1 Make an archive copy of the config-db or xml/db directory. 

2 Run install.exe (Windows).

3 When you run WLAN Management Software it will ask you what to do with the old network plans.

If WLAN Management Software Version 4.1 has already been installed on another client, and the 
option to copy the network plans to the server was selected, then do not select the option to copy the 
plans to the server. Likewise, do not select the option to copy the plans to the server, if the plans have 
already been copied to the server manually.

If this is the first installation of WLAN Management Software Version 4.1.15, then select the option 
to copy the plans to the server.

Downgrading to a Previous WLAN Management 
Software Version

If you need to downgrade from a WLAN Management Software 4.1.x version to a previous 4.1.x version, use 
the following procedure:

1 Back up the network plans, by copying the config-db directory to a location that is not in the WLAN 
Management Software installation path.

Note.  The format of the monitoring database in WLAN Management Software 4.0 is 
incompatible with the format in WLAN Management Software 4.1. Before you upgrade, 
uninstall WLAN Management Software 4.0 with the option to delete the monitoring 
database is selected. (See “WLAN Management Software Version 4.0 Monitoring database 
cannot be used in Version 4.1. (26384)” on page 30.)
Nortel WMS 2300 Series Release Notes 4.1.15
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2 Uninstall the current WLAN Management Software installation. Select to delete all but the license and 
the network plans.

3 Install the earlier WLAN Management Software software version.

4 After installation, copy the folders in the backed up config-db directory to the one that is created by the 
installation in step 3.

5 After installation, copy the folders in the backed up services-db directory to the one that is created by the 
installation in step 3.

When you start the downgrade version of WLAN Management Software, it opens the Default network plan. 
Use the File > Switch Network Plan menu bar option to open your plan.

If you need to downgrade the WSSs managed by WLAN Management Software, you can do so before or after 
the WLAN Management Software downgrade.  

Issues Resolved Since WLAN Management Software 
Version 4.1.14

802.11a channels have been disabled for use in France (32903)
Description   802.11a channels have been disabled for use in France 

When using copy/paste in the “default” radio profile an exception error is generated. (30961)

WMS crashes when a WSS is deleted from list, has bias changed or Radio Type selected changes from 
802.11b to 802.11g (21254)

WMS crashes when clicking on “Finish” when changing DAP serial number to the same serial 
number as another DAP. (20774)

Incorrect error message “Radio a is not supported” appears when changing the country code on a 
network plan. (33937)

Some country codes omitted from WMS drop-down menu. (33959)
Description   County codes for Caymen Islands, Anguilla, Montserrat, Korea Republic, Bahrain, Dominica, 
Grenada, Montserrat, St Kitts and Nevis, St Lucia, St Vicent and the Grenadines, Botswana, Tanzania, Zambia, 
and Zimbabwe are not listed in WMS country selection drop-down menu.

Note.  Nortel recommends that you do not downgrade to previous WLAN Management 
Software versions. In addition, WSS Software features that are new in WSS Software 
Version 4.1 are not supported in previous versions of WLAN Management Software.
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Issues Resolved Since WLAN Management Software 
Version 4.1.12

Attempting to copy and paste a service profile from one WSS to another WSS of a different model 
caused a Java exception. (25128) 

RF trend values were displayed in red even though they did not exceed a threshold. (27564)

Changing the model of a WSS could cause an exception. (27792)
Description   If you changed the model number of a WSS contained in the network plan, an exception could 
occur.

RF planning could calculate coverage incorrectly for 802.11b/g, if the coverage area for 802.11a did 
not contain more APs than the coverage area for 802.11b/g. (27829)

If you selected the Use System IP Address checkbox in the RADIUS configuration section, WLAN 
Management Software did not see it as an available change. (28824)

Message “Error: The server is currently unavailable due to critical errors encountered during 
startup.” displayed when starting WLAN Management Software. (29244)
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Description   Changing the model type for a switch in a network plan, then restarting the machine running 
WLAN Management Software Services, resulted in an error message when a WLAN Management Software 
client connected to the machine running WLAN Management Software Services.

WLAN Management Software crashed when configuring an SSID with encryption and a static WEP 
key was specified. (29249)

Inaccurate WLAN Management Software reports for WSSs with redundant APs. (29389)
Description   In a network where a WSS was configured as a redundant device (bias = low), WLAN 
Management Software reports incorrectly indicated that both the high-bias and low-bias WSSs had the same 
amount of throughput and the same number of clients. Cumulative data reports showed double the actual 
numbers.

Creating an Open Access Service Profile with an encrypted SSID, then specifying a key for Static 
WEP, caused WLAN Management Software to crash. (29412)

Applied changes for ACLs in policies only took effect when the ACLs were deleted or created, but not 
when the ACLs were modified. (29416)

Description   When you created an ACL using a policy, then applied the policy to a WSS, the ACL was 
correctly shown in the WSS’s configuration.  However, if you subsequently modified the ACL and deployed 
the changes to the WSS, WLAN Management Software indicated that the changes deployed correctly, but the 
ACL changes did not actually appear in the WSS’s configuration.

A policy containing Wireless Service Profiles and Radio Profiles could not be applied. (29659)

Selecting a single WSS created by the RF Planning function and pressing Ctrl+D did not allow you to 
delete the WSS. (29676)

In a Network Plan consisting of multiple floors, the WLAN Management Software Compute and 
Place function placed APs on the incorrect floor. (29679)

Deploying changes to a WSS caused the WSS to produce a core file. (29773)

Using certain IP address ranges generated Verification warnings. (29847)
Description   If you tried to configure devices in WLAN Management Software to use Class A IP addresses in 
a range higher than 126.0.0.0 (191.0.0.0 for Class B, 223.0.0.0 for Class C), WLAN Management Software 
indicated that the IP address was not in any standard class (A, B, or C).

Configuring or displaying static WEP keys whose first two characters were in the range of a-f (for 
example, ab234324234324234234234324) caused WLAN Management Software to crash. (30090)
320667-C Rev.04



Issues Resolved Since WLAN Management Software Version 4.0.18 23
The AP Redundancy dialog did not use max. configured AP count. (30553)
Description   The Select Bias and Device(s) for Redundancy dialog, used in the Setup AP Redundancy 
wizard, displayed the number of APs that could be booted by the switch, instead of the maximum that could be 
configured on the switch.

Following an upgrade, the event log indicated a Java exception related to null data received for a 
monitoring screen. (30926)

The About WLAN Management Software screen displayed an incorrect build version number. 
(31270)

Issues Resolved Since WLAN Management Software 
Version 4.0.18

Exception could occur if the Find Clients option was selected to find all users, but a Mobility Domain 
had not been selected. (25706)

Timeout could occur during a backup or restore of a network plan. (26781)

Exception occurred while a backup of a network plan was being restored. (27042)

Distributed APs converted from Auto-DAPs into statically configured APs were always assigned to the 
default radio profile, even if another profile had been selected for them. (27692)

WLAN Management Software allowed only one default route in a WSS configuration uploaded into 
WMS, and did not upload any of the switch's additional default routes. (28084)

Report Problem did not always send all the required files, and did not display a message upon failure. 
(28265)
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Description   In the current version of WMS, the timeout used by the Report Problem function has been 
increased to allow more time to send all the required files. In addition, if a failure does occur, WMS now 
displays a message to inform you of this.

WSS rejected a configuration deployment as invalid if the changes included a radio profile that was 
removed and then re-added. (28403)

The incorrect AP boot loader version was displayed in the Bootloader field of the Access Points tab. 
(25622)

In RF Planning, after configuring the unit of measurement for a building to be meters, the Clean 
Layout wizard showed the dimensions of small objects and lines in feet instead of meters. (27045)

After using the drop-ship method to configure a WSS, the switch’s WSS Software version number was 
not being displayed in the Version field of the Managed Devices tab. (27234)

The Service Profile wizard was unable to create a user that had a space character in its name. (27449)

Deleting an Auto DAP appeared in WLAN Management Software as a local change that could not be 
deployed. (27587)

It took 10-15 minutes to switch floors in a network plan when the floors contained a large number 
(more than 7000) of obstacles. (27736)

Java exception could occur while attempting to accept network changes. (24364)
Description   This issue occurred if a set of changes was reviewed, an object that had changes was deleted, 
then the accept option was selected. 

It was possible to use the System Setup wizard to configure a voice service profile on a switch running 
a WSS Software version that didn't support the option. (26202)

Name and description specified for the first RF obstacle created on a floor plan were applied to all 
other unedited obstacles. (26279) 

Description   This issue occurred because RF obstacles were associated with multiple layers in a floor plan. In 
the current release, they are associated only with Layer 0. 

After upgrade from WLAN Management Software Version 4.0 to Version 4.1, creating a backup of a 
network plan could result in a spurious timeout message even though the backup was created 
successfully. (26721)

Changing the unit of measurement of a drawing required rescaling the drawing. (17941)

WLAN Management Software did not use countermeasures start and stop traps from WSSs. (21007)

Rogue summary report could take a long time to generate. (24299)
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Description   A rogue summary report could take 5 minutes or more to generate if the scope was Network 
Plan or Mobility Domain. To fix this issue, WLAN Management Software Version 4.1.12 provides a new 
option for setting up rogue summary reports. You can select the device type (rogue, interfering, Ad-hoc, or all) 
to list in the report. The all option lists rogues, interfering devices, and ad-hoc devices, and is equivalent to the 
functionality present in the previous release. (For more information, see “New option for rogue summary 
reports. (24299)” on page 31.)

Third-party APs could not be placed on the floor plan. (25275)
Description   WLAN Management Software could place a third-party AP on the wrong layer of a network 
plan. If this occurred, the AP still appeared on the Objects to Place tab. However, if the AP was selected and 
placed on the floor plan, the AP disappeared from the Objects to Place tab but did not appear on the floor plan.

AP locations in work orders could be incorrect for non-rectangular coverage areas. (25319)
Description   If a coverage area was not a simple rectangle, the coordinates used in the work order for 
placement of APs on the floor was incorrect. This issue is fixed in WLAN Management Software Version 
4.1.12. The fix includes a change to the origin reference point for AP placement. In WLAN Management 
Software Version 4.1.12 and later, the origin is the upper left corner of the coverage area and has coordinates 
0,0. (Typically, this origin point will not match the origin point used on the floor plan itself.) 

Name and description specified for the first RF obstacle created on a floor plan were applied to all 
other unedited obstacles. (26279) 

Description   This issue occurred because RF obstacles were associated with multiple layers in a floor plan. In 
the current release, they are associated only with Layer 0. 

The configuration wizards and Properties dialogs for APs did not have a Load Balance Group box. 
(23719)

RF Planning used switches in other sites for AP connections if no other switches were available. 
(25173)

Description   When RF Planning assigns APs to WSSs, it checks different sources for switches, in the 
following order:

1 Use switches from the coverage area’s list of preferred switches first.

2 If the coverage area’s preferred switch list is empty, use switches from a wiring closet in the same 
building.

3 If the wiring closet has no switches or is not defined, use switches in the same Mobility Domain or in the 
same site (if no Mobility Domain is configured).

4 If no switches are available from any of the sources listed above, create a new switch.
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In previous versions of WLAN Management Software, RF Planning looked for switches in other sites, before 
creating new ones, and used the switches from other sites if found. This resulted in an impractical 
configuration.

Changes to the default RADIUS parameters were not applied to RADIUS servers created after the 
default changes. (12301)

WLAN Management Software reported that changes occurred even when the changes canceled each 
other out, but did not list the changes. (16212)

Childless objects in the Organizer panel had plus signs. (18188)

WLAN Management Software sent spurious email notification about port status changes when a 
network plan was opened or closed. (18882)

Java issue caused internal application error during import of configuration files. (19558)

Default rogue location colors did not automatically take effect. (20235)

Finish button after a USM user was configured was unavailable until you clicked on another field. 
(20750)

Deleting a switch from the Equipment list stopped rogue detection and monitoring for all switches. 
(20970)

Redundant Distributed APs configured on multiple WSSs were counted separately for licensing, if 
they were configured independently on each WSS. (21336)

Deleting a secondary Distributed AP connection could cause an exception. (23281)
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Known Issues

A non-administrative user cannot run WLAN Management Software. (12155)
Description   WLAN Management Software generates an exception if a user does not have administrative 
privileges on the WLAN Management Software host. This issue involves the Java Virtual Machine (JVM) that 
is being used by WLAN Management Software and should be resolved with a future release of JVM.

Workaround   To use WLAN Management Software, users must belong to a “Power Users” group or be 
added to the administrators group in the Windows operating system.

When the VLAN name is composed entirely of numbers in ACL VLAN mappings imported from the 
CLI, WLAN Management Software assumes that the VLAN name is a VLAN ID. (12682)

Description   A VLAN can be specified in the CLI by its VLAN ID or its VLAN name. When the CLI 
command is imported into WLAN Management Software, the VLAN reference type is not apparent. If the 
VLAN reference is composed entirely of numbers, WLAN Management Software assumes that the reference 
is a VLAN ID. Otherwise, WLAN Management Software assumes that the reference is a VLAN name. 

Workaround   Do not use VLAN names that consist entirely of numbers.

Importing of a floor plan in JPEG format might fail with a color conversion exception. (14631)
Description   On rare occasion, importing a floor plan in JPEG format might fail with the following Java 
exception: 

sun.awt.image.ImageFormatException: Unsupported color conversion request. 

This exception occurs because of unusual color palette settings in the file.

Workaround   Using a JPEG editing tool, manually remove all extraneous information possible to remove the 
problematic color information. Alternatively, convert the JPEG file into a GIF file to import.

Size or location adjustments of shared coverage areas with identical dimensions might cause problems 
when you run Compute and Place. (14631)

Description   When shared 802.11a and 802.11b/g coverage areas are created, one coverage area is directly 
placed on top of the other. If you resize or move one of the coverage areas, the other coverage area is now a 
different shape or in a different location. Running Compute and Place might not work.

Workaround   Use the dimension toolbar icon to set the center and size of each coverage area to identically 
match each other.

When importing a CAD file (DWG/DXF), any lines with arrowheads will display incorrectly. (15906)
Description   When importing DXF or DWG CAD files with lines that have line ends (arrows, dots, and so on) 
the objects get imported with huge arrows at the ends of the lines.

Workaround   Use a CAD program to remove any arrowheaded lines, or modify the line’s properties to not 
display an arrowhead. Alternatively, delete the line while in the Edit Content page of the Floor wizard in 
WLAN Management Software.

WLAN Management Software does not support the Ctrl + drag-and-drop mouse operation. (16425)

Polling interval for client session cannot be changed. (17585)
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Description   By default, WLAN Management Software polls every 30 seconds for performance monitoring 
of a client chosen from the watch list. This polling interval cannot be modified.

Enabling STP on a WSS’s management VLAN causes a configuration deployment to fail. (17668)
Description   If you use WLAN Management Software to enable STP on a WSS's management VLAN, then 
deploy the configuration, the deploy fails. The failure occurs because the management interface must pass 
through the standard Listening and Learning states, which together take at least 30 seconds, before the 
interface can change to the Forwarding state. Until the interface reaches the Forwarding state, the switch 
cannot receive traffic, such as configuration deployment from WLAN Management Software, on its 
management interface.

Workaround   If this occurs, wait 30 seconds for the interface to reach the Forwarding state, then accept the 
WSS's change in WLAN Management Software.

Disabled radio on operational AP does not turn red if the AP or WSS becomes unavailable. (18330)
Description   In the Explore and Status Summary windows of the Monitor tab, the operational state of Nortel 
equipment is indicated by color, and is also indicated in the Status column of the Status Summary window. For 
example, if a WSS goes down, its icon turns red. However, if the AP or WSS for a disabled radio goes down, 
the radio does not turn red. In addition, the value in the Status column of the Status Summary window changes 
from Operational to Not Applicable. (It is normal for a disabled radio’s state to be Operational, since disabled 
radios perform RF sweeps for rogue detection.)

Workaround   This issue is cosmetic only and does not affect other information displayed for the equipment.

Daylight Savings Time or timezone changes are not automatically detected in WLAN Management 
Software. (18422)

Description   If a Daylight Savings Time or timezone change occurs on the host machine where WLAN 
Management Software is running, displayed timestamps are not automatically updated in WLAN Management 
Software. 

This issue is actually a Java Virtual Machine (JVM) issue. The JVM does not detect date or time changes made 
at the OS level. See the following web page:

bugs.sun.com/bugdatabase/view_bug.do?bug_id=4216582

Workaround   Exit and restart WLAN Management Software to place a date or time change made on the host 
machine that is running WLAN Management Software into effect.

Opening a network plan that has more APs than the license allows sets all WSSs in the plan to 
unmanaged. (19841)

Description   If you open a network plan that has more APs than your license level allows, WLAN 
Management Software deselects the managed option on the switches. 

Workaround   To manage the switches, remove enough APs to bring the total down to the allowed limit, then 
reselect the managed option for each switch and save the changes. (The managed option is available on the 
System & Administrative page of the WSS wizard.) Alternatively, you can upgrade your license. 

dbtools command line utility is not applicable to backing up or restoring network plans. (20416) 
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Description   WLAN Management Software 4.1 automatically saves backups of network plans, and enables 
you to configure backup options, create backups, and restore network plans from backups. However, the 
network plan backups cannot be managed using the dbtools command line utility. 

Workaround   To manage network plan backups, use the Backup/Restore dialog (Tools > WLAN 
Management Software Services Backup/Restore).

License upgrade requires restarting WLAN Management Software Services. (21342)
Description   WLAN Management Software Services checks license information when you start the server. 

Workaround   If you upgrade a license, do the following to place the license upgrade into effect:

1 Select File > Close to log off of WLAN Management Software Services.

2 Select File > Connect, then click Next to log back on to WLAN Management Software Services.

Radio statistics for Auto DAPs are not correct. (21644)
Description   The radio statistics for DAPs that are configured by the Distributed AP profile (Auto-DAP 
profile) are not correct. However, statistics for statically configured APs (Distributed and directly attached) are 
correct.

Network ports and wired authentication ports are not displayed in the Monitor Explore window. 
(22289)

Description   In WLAN Management Software 4.1, WSS ports configured as network ports or wired 
authentication ports are not displayed in the Monitor Explore window, even though these port types were 
displayed in WLAN Management Software 4.0. However, ports configured for directly connected APs (AP 
access ports) are displayed.

Workaround   To view port configuration information:

1 Select Configuration on the tool bar.

2 Select the switch in the Organizer panel.

3 Click on the plus sign next to the switch.

4 Click on the plus sign next to System.

5 Click Ports. Port configuration information is displayed in the Content panel. 

To monitor port activity, select Tools > Performance Monitor from the menu bar. 

Repeated error message when copying a notification profile without editing the name. (22759)
Description   If you select a notification profile in the Notification Profiles table and click the copy icon, then 
click OK in the Notification Profile Properties dialog without first editing the profile name to make it unique, 
WLAN Management Software displays the following error message multiple times:

A Notification already exists with the same key [Trap Type] 

Workaround   Despite the repetition, the messages mean simply that you need to edit the profile name to 
make it unique. Click OK to clear the messages, then edit the profile name.

Mouse must be still during clicks when selecting multiple rows in tables. (23189) 
Description   WLAN Management Software supports multiple selection of objects using the 
CTRL+right-click method. However, if you move the mouse as you are clicking, the previously selected rows 
are deselected. 
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Workaround   To avoid this issue, make sure the mouse is not moving before you click.

Rogue Detection report fails after short interval. (24877)
Description   When a WSS reports RF information to WLAN Management Software, any non-ASCII 
characters that appear in SSID names being reported to WLAN Management Software will be translated into 
their hexadecimal equivalents. For example, a <TAB> character would appear as 0x09. This applies to any 
character above 0x7e. The hexadecimal characters can result in SSID strings that are longer than the maximum 
size supported (32 characters).

WLAN Management Software Version 4.0 Monitoring database cannot be used in Version 4.1. (26384)
Description   The format of the monitoring database in WLAN Management Software Version 4.0 is 
incompatible with the format in Version 4.1. Therefore, after you upgrade, you will be unable to open a plan 
saved in Version 4.0 if the plan still has its monitoring database.

Workaround   First, uninstall WLAN Management Software Version 4.0 and make sure the option to delete 
the monitoring database is selected. (You can deselect the options to delete the network plans, access control, 
and license information.) After uninstalling Version 4.0, install Version 4.1. 

Email Notification is not supported. (26684)
Description   WLAN Management Software 4.0 had some email notification fields on the Network tab of the 
client Preferences dialog. These fields were not supported in WLAN Management Software 4.0 and are not 
supported in WLAN Management Software 4.1. The fields were still present in WLAN Management Software 
4.0 but have been removed from WLAN Management Software 4.1.

Local change results in Network change that cannot be accepted or undone. (30946, 31067)
Description   This issue occurs in the following scenario:

1 On a WSS, SNMP is enabled with the security type set to Encrypted and the protocol set to USM 
(SNMPv3).

2 The WSS is uploaded into WLAN Management Software.

3 On the WSS, the command to disable USM is entered at the CLI.

4 The resulting network change is accepted in WLAN Management Software.

5 On the WSS, the configuration is saved, and the WSS is rebooted.

6 After the WSS is rebooted, WLAN Management Software indicates a network change that USM has been 
changed from enabled to disabled.  However, this change cannot be accepted or undone; clicking Accept 
or Undo has no effect.

Workaround   This issue occurs because disabling USM when the security type is set to Encrypted is not a 
valid configuration. After the network change is accepted, WLAN Management Software automatically 
re-enables USM.  This local change results in a network change being available: In the network, the USM 
setting is disabled, while in WLAN Management Software, it is enabled.  However, since no actual change 
took place on the WSS, the network change cannot be accepted or undone.

If you encounter this issue, do the following to eliminate the network change indication in WLAN 
Management Software:

1 On the WSS, enter the following commands:

WSS# set ip snmp server disable
WSS# set snmp security unsecured
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2 In WLAN Management Software, accept network changes.

Documentation Errata
The following information was omitted from the WLAN Management Software 4.1 manuals and online help.

Clarifications about the Layout Cleanup option. (22156, 26056, 26060)
Description   The Clean Layout option does not do anything with objects that are grouped. Also, the option 
does not clean up objects that are on separate layers. For example, if two parallel lines are close enough to be 
cleaned up, but each line is on a separate layer, the lines will not be cleaned up.

To ungroup objects in a CAD drawing, use the explode command, or its equivalent if your application does not 
have a command by that name. Likewise, to group objects, use the create group command or its equivalent.

The instructions for cleaning up a drawing refer to specific command names in CAD applications. The 
commands are mentioned in WLAN Management Software documentation as a guide for finding the 
appropriate commands or options in your CAD application. However, the best source of information about 
how to use your CAD application is the user documentation for that application.

New option for rogue summary reports. (24299)
Description   WLAN Management Software 4.1.12 provides a new option for setting up rogue summary 
reports. The new option lets you filter the results based on the rogue type (rogue, interfering, Ad-hoc, or all). 

To specify the rogue type, click on the Value field on the Rogue Summary Report setup dialog, and select one 
of the following from the drop-down list:

• Rogue

• Interfering

• Ad-hoc

• All (This option displays all three types: rogue, interfering, and ad-hoc.)

The default is Rogue.

Clarification about AP radio channel information in RF Planning. (25215) 

The Assign Channel task in RF Planning assigns channels to the APs in a building. For APs that are in the 
network plan but are not yet deployed and managed by WLAN Management Software, the channel number is 
changed to match the results of channel assignment. However, the channel is not changed for APs that are 
running in the live network and are being managed by WLAN Management Software. For these APs, WLAN 
Management Software displays the channels that are in use on the live APs.

To make the APs in the live network use the channels assigned by RF Planning, deploy the configuration to the 
network. After you deploy the configuration with the new channel settings, the channel information on the 
floor plan should match the channels assigned by RF Planning. 

The APs on a floor plan in RF Planning are color coded to indicate their monitored status:

• Green—Up

• Yellow—Up (but with minor service degradation)

• Orange—Up (but with major service degradation)

• Red—Down
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• Blue—Unknown

An AP with a blue background is not in the live network even though it is on the floor plan. The channel 
number for this AP will match the channel number assigned by RF Planning. However, an AP with a green 
background is running in the live network, and this AP’s channel number will indicate the channel on which 
the AP is operating, which is not necessarily the channel assigned by RF Planning. 

If RF Auto-Tuning of channels is enabled, the channels can change on live APs even if you do not change 
them.

Origin reference point in work orders is based on the coverage area. (25319)
Description   In WLAN Management Software Version 4.1.12 and later, the origin reference point used in 
work orders to indicate AP placement is the upper left corner of the coverage area. (Typically, this origin point 
will not match the origin point used on the floor plan itself.) 

Network plan summary includes Network Domain information. (25501)
Description   When you select the Configuration tool bar option, then select the network plan name in the 
Organizer panel, summary information for the plan is displayed in the Content panel. In WLAN Management 
Software version 4.1.12, Network Domain information is also displayed. The Network Domain name is 
displayed, and the seed switches and member switches are listed.

Clarification on the Associations Tab of the Coverage Area Properties dialog. (25998)
Description   In the Coverage Area Properties dialog, one of the sections on the Associations tab is Radio 
Policy. In the Radio Policy section is a Radio Profile list. The manual and online help state that you can select 
a radio profile from this list. In fact, you can select a radio profile policy, not an individual radio profile 
configured on an individual switch. All radio profile policies configured in the network plan are listed. In 
addition, a default policy is listed. If you select default, the default radio profile settings are applied to the 
coverage area.

Displaying the geographical location of a client associated with a rogue. (26116)
Description   If building and floor information for the site is modeled in the network plan, you can display the 
likely physical location of a rogue, as well as clients associated with the rogue. WLAN Management Software 
displays the floor plan for the floor where a rogue’s client is believed to be located, and displays the areas 
where the client is probably located.

To display the location of a client associated with a rogue:

1 Select the rogue in the rogue list.

A list of the clients associated with the rogue appears under the Clients tab.

2 Select the client under the Clients tab.

3 Click  on the toolbar. The Device Location screen appears, indicating the approximate location of 
the client.

The client is most likely in the vicinity of the area indicated by the red squares in the floor plan. The 
number in red on the legend is the probability that the client is where the display indicates.

Read-write-notify and read-write SNMP community string access types can be configured but WSS 
MIBS currently do not support write operations. (26140)
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Description   WSS Software switch MIBs currently support Get and Get Next commands, but not Set 
commands. You can select read-write-notify or read-write as the access type when configuring an SNMP 
community strings on a WSS. However, the “write” portion of the access type currently is not supported. 
Using these access types do not cause an error. Get and Get Next operations are still supported.

Deletion of monitoring database during uninstall is no longer optional. (26384)
Description   In WLAN Management Software 4.0.18 and earlier, deletion of the monitoring database during 
uninstall was optional. In WLAN Management Software 4.1.12 and later, deletion of the monitoring database 
automatically occurs during upgrade and cannot be deselected. (See “WLAN Management Software Version 
4.0 Monitoring database cannot be used in Version 4.1. (26384)” on page 30.)

Third-party APs placed on a floor plan are included during coverage planning. (27402)
Description   If you place a third-party AP on a floor plan, the third-party AP is included in coverage 
calculations. For example, if WLAN Management Software planning determines that 12 APs are needed to 
provide coverage on a floor, any third-party APs you have already placed on the floor are included in those 12 
APs.

Clarifications about Network Domain configuration.
Description   To simplify configuration, WLAN Management Software assumes that the extent of the 
Network Domain is the same as extent of the entire network plan. WLAN Management Software also 
automatically sets the seed affinities on each switch as described in Table 1. 

Make sure to select the seed switch as a member. For the Network Domain to work properly, the seed must 
also be configured as a member. 

Details about the Optimize option in RF Planning.

Table 1. Affinities for Network Domain Seeds

Affinity Value Assigned To...

10 The switch itself, if it is a Network Domain seed. 

8 Another switch in the same Mobility Domain, if that switch is both a Network Domain 
seed and the seed switch for the Mobility Domain the two switches are in.

5 All switches that do not fit either of the descriptions above.

Note.  Nortel recommends that you allow WLAN Management Software to automatically 
assign affinity values instead of using the CLI to manually set them. Even if do you use the 
CLI to set them, WLAN Management Software does not replace the affinity values it 
automatically sets with values set on individual switches. Thus, if you accept network 
changes that include Network Domain affinity changes, WLAN Management Software 
ignores the affinity changes and overrides them with auto computed values. As a result, 
WLAN Management Software might generate local changes.
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Description   The Optimize option compares RSSI values among live AP access points and compares the 
values to the values predicated by WLAN Management Software. If the values do not match, WLAN 
Management Software looks for an RF obstacle in the plan that might be causing attenuation, and adjusts its 
attenuation value in the plan so that the predicted RSSI matches the measured RSSI. However, the following 
should be noted:

• The Optimize feature adjusts attenuation values only if the network plan has an RF obstacle in the line of 
sight between measurement points (for example, between APs that made the measurements). The manual 
and online help incorrectly state that WLAN Management Software will create an obstacle to account for 
the RSSI if one does not already exist.

• Only one obstacle between any two measurement points is adjusted, even if there are multiple obstacles 
between the measurement points.

• The measurements reflect how well the measuring APs can hear one another, and do not directly measure 
how well clients can hear the APs. For example, if the APs are mounted on the ceiling, attenuation of 
their signals to one another might be less than the attenuation of the same signals when received by clients 
on desktops in cubicles and offices.

Clarification about deleting APs from a network plan. (28733)
Description   In WLAN Management Software 4.x, an AP or DAP and all of its redundant connections on 
other WSSs are deleted when any of the following actions are taken:

• A WSS configured with one of the connections is deleted from the Configuration area.

• The AP or DAP is deleted from the Configuration Access Points table.

• The redundant AP or DAP connection is cleared from a WSS using the CLI, and those network changes 
are subsequently accepted in WLAN Management Software.

• The AP or DAP is deleted from the RF Planning area.

Note that the AP or DAP is not deleted when an entire floor is deleted in RF Planning.

If you want WLAN Management Software to delete some, rather than all redundant connections, click the AP 
and select Properties and select the AP redundancy tab, or use the AP redundancy wizard, shown in the 
Access Points Configuration area.
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